
Welcome to the XSENSOR Pressure Imaging System

First Things First:
Activating the software
Calibration Folder
Session Folders

Basic Features:
Creating a new XSENSOR session
Recording a session
Viewing sessions in different modes
Printing

Advanced Features:
XSENSOR Session folders
Sensor Groups
X3 DISPLAY manager

What's new in this release

Major Engine Overhaul

Direct to disk recording. 
Collected data is saved immediately to the disk reducing the risk of data loss.

Increased session sizes. Allows for files >500 GB. 
Supports multi-core CPUs to allow simultaneous sensor recording. 

Multi-spk sensors or multi-sensor configurations record at higher rates.
Faster load/save times. 

Load and save in under a few seconds.

User Interface Improvements

Basic and Advanced Medical modes 
Customizable toolbars and docking window layout. 
Auto-optimizing dock window layout in Medical Basic mode. 

The docking windows are automatically positioned to show the best view of the sensor area.
Clipboard copy. 

Select and copy pressure data directly from the 2D views.
Integrated 2D numeric view. 

A unified 2D view that can toggle pressure numbers on and off.
2D zoom mode. 

Enlarge regions of the 2D map to get a better look at high resolution sensor data. 
Very useful when used with the 2D numeric viewing mode.

2D rotation of rectangular sensors. 
Change the 2D orientation of any sensor for optimized viewing or printing.

New Features

Support for Digital Video (DV) camera capture. 
Multiple Image attachments. 
Notes templates. 

Pre-populate notes for consistent data entry.
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Activating the XSENSOR software

XSENSOR software programs are licensed products, and require product keys for activation. The product key is 
distributed with the installation disk, and consists of a licensee and a 25-digit code.

Product keys are valid for software updates for a limited time period, based on the product licensing through which the 
product keys are obtained. Licensee and product key information is displayed in the About XSENSOR Pressure Imaging 
System dialog box (to open this dialog box, from the Help menu, choose About XSENSOR).

To activate the XSENSOR software:
1. Start the software and the Product Key dialog box appears. 
2. In the Licensee field, type the licensee name. 
3. In the Product Key fields, type the product key. 
4. Select OK to finish.

Calibration File Folder
The first time the software is run, a prompt may appear requesting a location for the "XSENSOR Calibrations" folder. This 
folder is required by the software so that calibration files can be downloaded from the sensors and quickly retrieved at a 
later time. Any write-able folder location, including network folders, can be selected.

If you are unsure as to which folder should be selected, use the following instructions:

1. Highlight "My Documents" and select "Make New Folder".
2. Replace the "New Folder" name with "xsensor calibrations".
3. Select "OK".

The "xsensor calibrations" folder is now used to store calibration files. The folder does not need to be named "xsensor 
calibrations".
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Quick Start

Record a session.
View a session.
Save and close a session.

Medical Modes: Basic and Advanced
The XSENSOR Medical software has two major modes of operation, Basic and Advanced.

The Basic mode, which is on by default, presents a streamlined user interface with a focus on pressure mapping and 
offering the most common operations via the menus and toolbar. The five option tabs of the Advanced mode have been 
condensed down into a single tab with only the most impacting options. The Basic mode also has an auto-dock feature 
that moves the docking windows (like statistics, pressure legend, and notes) automatically to the side or bottom of the 
screen depending on the sensor layout so as to maximize the viewing area of the sensor.

The Advanced mode, enables more features, such as video recording, file comparison, sensor groups, X3 DISPLAY 
connectivity, import/export csv data, and others.

The toolbar menu shows the active mode. Select To switch between modes, select the Switch to Mode option under the 
active mode menu item. This causes the software to restart in the new mode. By default the software will always start in 
the Basic mode. To always start in the Advanced mode, uncheck the Default to Basic Mode item under the active mode 
menu item.

Opening an XSENSOR session

XSENSOR sessions can be opened in any of the ways shown below. Sessions created with earlier versions of XSENSOR 
are automatically converted into the current format when opened.

To open a session:
1. Open the Open dialog box in one of the following ways:

Click the Open  toolbar button; 
OR

From the File menu, choose Open;
OR

Press <Ctrl+O>. 
2. In the Open dialog box, navigate to the folder that contains the saved session file (these have a *.xsn file extension). 
3. Select the file and click the Open button, or double-click the file to open the saved session. 
Tip: The bottom of the File menu contains a list of the most recently opened XSENSOR sessions. Choose a session from 
the list to open it.

To open a saved session from within a session folder:
1. Open the Client window. 
2. Expand the client folder by clicking the Plus  sign next to the folder name. 
3. Right-click the name of the session and choose Open Session to open it. 

Recording a session

After a sensor system has been connected to the computer and a session is created, recording can begin immediately. 
The basic recording settings, such as speed and duration, are specified when a session is created. The advanced
recording settings can be modified at anytime.

To record a session:
1. Either create a new session, or open an existing one. When opening an existing session file, any new frames are 

appended to the end of the file. 
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2. When the Preview Mode is active, the Record Frames button turns yellow . Click this button to view live sensor 
images without recording them. 

3. To start recording, click the Record Frames  toolbar button, or press the <F8> key. 

4. To stop recording, click the Stop Playback/Recording  button, or press the <Spacebar>. 

Note: The Record Frames button is disabled if the session file is read-only. 

See Also:
Setting playback/recording options
Viewing recorded frames
Viewing session statistics

2D View - Basic

The basic 2D view is the default viewing mode.   This view shows a 2D representation of the recorded sensor pressure. 
The numbers across the top and sides of the 2D image correspond to the numbers printed along the edges of the 
sensors. Some of the more common features used with the 2D view include viewing the pressure values associated with 
the isobar colors, and copying pressure data directly from the view into the clipboard.

To enter the 2D view mode, from the View / Current View menu and choose 2D View, or click the 2D View  toolbar 
button.

The 2D viewing mode can be configured to display images in a variety of ways. See 2D Options for more information.

View Pressure Values
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One of the simpler methods of viewing the pressure values behind the colored isobars is to hold the left mouse button 
down and drag the mouse around the sensor. The pressure under the mouse is shown in the middle of the status bar. 
Another method involves enabling the 2D Numeric View which shows the numbers directly over the pressure image. A 
third method is via the 2D Magnifier window.

Clipboard Copy
A region of pressure data can be copied directly from the 2D view into the clipboard. While holding the <SHIFT> key 
down, press the left mouse button and draw the mouse pointer to form a selection rectangle. The region in the rectangle 
will show inverted colors. Release the left mouse button and the inverted rectangle will remain. Use <CTRL>+C to copy 
the sensels. The copied data can be pasted into any text editor or spreadsheet program.

Save and Close a session

To save a session file:
Select one of the following commands:

Click the Save  toolbar button; 
OR

From the File menu, choose Save;
OR

Press <Ctrl+S>;
OR

From the File menu, choose Save As.

The first three commands save the session file over any existing file with the same name.  The Save As command is used 
for creating a new copy of a session.  If a session is new, then first three save commands cause the Save As window to 
appear prompting for a name and folder location.

Managed sessions (i.e.: sessions created within session folders) are automatically named using the folder name and a 
timestamp.  Using the Save As command with a managed session produces an unmanaged copy of the session.  This 
unmanaged session is not accessible from the session folder.

To close a session file:

1. A session can be closed in two ways: 

From the File menu, choose Close; 
OR

Click the Close  button on the right-hand side of the session title bar. 
Note:If the session window is maximized, be careful to click the bottom Close button, and not the XSENSOR 
application's Close button, which is directly above it, as shown here.

2. If a session is new or is modified, a pop-up message asks to save the changes: 

Click Yes to save the session file and close it. 

If the session is managed (i.e.: created inside a session folder), click Yes to save it inside that folder. 

If the session is unmanaged (i.e.: created outside a session folder) and is being saved for the first time, the 
Save As window appears. Choose a folder location and type a file name. Click Save to save and close the 
file. 

If the session is being saved for the first time, the Save As window appears. Choose a folder location and 
type a file name. Click Save to save and close the file.

Note: Unmanaged session files are never shown under a session folder. In order to include an unmanaged 
session file under a sessionfolder, the session must be imported into the folder.
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Click No to close the session without saving any changes made since it was last saved. 

Click Cancel to return to the session without closing it.

Seating Assessment Guide

The Seating Assessment Guide is a tool for assessing the effectiveness of different seating surfaces. By using a fixed 
assessment procedure, the software helps ensure consistency when pressure imaging of multiple surfaces. Reporting 
tools are available at the end of each assessment, allowing review of the gathered information to make an effective 
seating selection.

The Guide automatically track assessments for multiple clients via a custom database. The database can be secured 
using a password such that only the operator can view confidential client information.

Links
Assessment Database
Assessment Clients
Client Diagnosis
Surface Assessment
Surface Assessment: Imaging and Review
Assessment Summary
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Medical Modes: Basic and Advanced
The XSENSOR Medical software has two major modes of operation, Basic and Advanced.

The Basic mode, which is on by default, presents a streamlined user interface with a focus on pressure mapping and offering the most 
common operations via the menus and toolbar. The five option tabs of the Advanced mode have been condensed down into a single tab 
with only the most impacting options. The Basic mode also has an auto-dock feature that moves the docking windows (like statistics, 
pressure legend, and notes) automatically to the side or bottom of the screen depending on the sensor layout so as to maximize the 
viewing area of the sensor.

The Advanced mode, enables more features, such as video recording, file comparison, sensor groups, X3 DISPLAY connectivity, 
import/export csv data, and others.

The toolbar menu shows the active mode. Select To switch between modes, select the Switch to Mode option under the active mode 
menu item. This causes the software to restart in the new mode. By default the software will always start in the Basic mode. To always 
start in the Advanced mode, uncheck the Default to Basic Mode item under the active mode menu item.

Seating Assessment Guide

The Seating Assessment Guide is a tool for assessing the effectiveness of different seating surfaces. By using a fixed assessment 
procedure, the software helps ensure consistency when pressure imaging of multiple surfaces. Reporting tools are available at the end of 
each assessment, allowing review of the gathered information to make an effective seating selection.

The Guide automatically track assessments for multiple clients via a custom database. The database can be secured using a password 
such that only the operator can view confidential client information.

Links
Assessment Database
Assessment Clients
Client Diagnosis
Surface Assessment
Surface Assessment: Imaging and Review
Assessment Summary

Assessment Database
The Assessment Guide organizes a user's clients and seating assessments by associating them with a user name and storing them in a 
database folder. Initially the user name is entered either via Create Database screen, or retrieved from the X3 DISPLAY via the Sync 
function.

The Assessment Guide can track one or more user databases, each of which can be password enabled to protect client confidentiality. 

Creating an Assessment Database
An assessment database is created with a few easy steps. Open the Seating Assessment Guide, select New to view the Create 
Database screen. 
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Database Creation screen

Next enter a user name. This can be anything like a last name or ID, though it should be used to associate the database with the user. 
Once the database is created, the user name cannot be changed. Please be aware that user names must be unique. 

The Assessment database can be protected with a password. Select Enable Password and enter a password in the field. Note that for 
the Create Database screen, this field shows the characters typed. Be sure others are not viewing the screen while entering this 
password.

Select Create to proceed to the Client list.

Syncing an Assessment Database
The Assessment Guide has the ability to synchronize a database located on an X3 DISPLAY with its local database. This means that 
any changes to client details are refreshed in either database (with the most recent change taking precedence.) Any assessments 
created or updated on the X3 DISPLAY are automatically copied to the local database. Conversely, local database assessments are not 
copied to the X3 DISPLAY due to the memory constraints of that device.
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To synchronize an X3 DISPLAY Assessment database, connect the X3 DISPLAY to the computer via the ActiveSync cable. Confirm that 
the device is connected via the Microsoft ActiveSync window, then select the Sync function. The function automatically scans the X3 
DISPLAY for changes.

When an assessment database is found on the X3 DISPLAY, the user name is shown on the Sync screen. If the database is password 
protected, then the password must be entered. The Storage Card list shows which storage card the assessment database was found on. 
Select Login to begin synchronizing the assessment databases.

If the X3 DISPLAY database user name is not already in the desktop database, then it is added and any client details and assessments 
are copied.

Please be aware that user names must be unique, and any matching user names will cause all of the client and assessment data to be 
merged into one database folder.

Opening an Assessment Database

The Login screen shows the list of available user databases. The password field is appears if a password is required for the database.
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Database Login screen

Select a name and then Login to proceed to the Client list.

Password Protection Note:

The Guide uses passwords to protect the confidential client list and prevent other users from opening the Assessments via the Guide 
tool. The assessment files can still be opened as normal XSENSOR sessions, however, these files do not contain any of the client 
details.

Database Options
The Database Options screen allows changing some of the assessment settings.

Settling Time and Imaging Time define adjustable durations for the Seating Assessment Guide. The Settling time is the duration from 
when a patient first sits on a cushion to when it has settled (or compressed) sufficiently to represent the cushions normal state. The 
Imaging time is the duration over which the assessment pressure image is recorded. Partial minutes can be selected by entering a 
fraction. For example, 1.5 minutes means 1 minute, 30 seconds.

Use Metric units for Client Details toggles between Metric and Imperial unit systems for client details like height and weight. Pressure 
readings and contact area use the regular software options. 
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Database Options screen

Assessment Clients
Seating assessments are always carried out in the context of a client. The assessment guide can store information for multiple clients.

Begin an assessment by creating a new client, or selecting an existing one via the Client Selection screen. All previous assessments for 
existing clients are accessed by selecting their profile on this screen.

Client Section screen

Open Existing Clients
Select an existing client by tapping on their name or ID and then tapping Next.

Create New Clients
Create a new client by selecting the name field containing New and tapping Next. Enter a first and last name for the new client and select 
OK.

After a new client is created or an existing one is selected from the list, the Client Details screen appears.
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Delete Clients
Clients can be removed from the database. Select a client and tap Delete. This function should be used with caution as it will remove all 
assessments associated with the client.

Client Details
The Client Details screen contains details about a client that may be relevant for the seating assessment. These details can be changed 
by tapping the fields. Most of these fields are information only, however, the gender field affects the gender imagery used on some of the 
client diagnosis screens.

The unit system (Metric vs Imperial) used for the Height and Weight fields is selected on the Database Options screen..

Client Details screen

From the Details screen select Prev  to return to the Client list, or Next  to proceed to the Client Assessments
screen.

Client Assessments
The Client Assessments screen lists all of the current client's assessments, one assessment per row. At the top of the list is a row for 
creating new assessments. The four surface columns show the names of the cushions used for each surface that has been recorded in 
the assessment. The date field shows the creation date of the assessment.
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Client Assessments screen

Open Existing Assessments
Open an existing assessment by tapping its row and select Next. The software will open the assessment to the Summary Review
screen.

Create New Assessments

Select the top row of the list, labeled New, and tap Next  to proceed to the Diagnosis Condition screen. (At this point, the 
software will search for any connected sensor pads. If none are found, the software will remain on the Client Assessments screen.)

Delete Assessments
Select an assessment and tap Delete. Use caution as this will permanently remove the assessment.

Client Diagnosis
The Diagnosis screens are used to record aspects of a client's health condition that may be relevant to a seating assessment. Specific 
medical conditions can be flagged on the Condition screen. Surface tissue damage can be indicated on the Skin screen. The Risk 
screen allows for a health risk assessment using the Braden Scale.

Diagnosis: Condition
The Diagnosis Conditions screen shows four categories of conditions. Tapping any of these categories will open the Conditions Detail

screen. A notes button  allows entry of a page of notes pertaining to the selected conditions. If the condition of the patient is not 
included on these lists, please describe the condition by using the Notes section. This description will appear in the assessment report.
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Diagnosis Conditions screen

On the Conditions Detail screen, tap all conditions that apply to the client. Select Prev  or Next  to navigate 

between the Details screens, or select Finish  once all conditions are specified.

Conditions detail screen

Diagnosis: Skin
The Skin screen allows highlighting parts of the skin that may have wounds. Tap each color circle to select the appropriate skin wound 
level corresponding to the legend on the right side of the screen. A notes button allows entry of a page of notes that are specific to the 
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Skin condition. 

Diagnosis Skin screen

Diagnosis: Risk
The Risk screen shows the client's Braden Risk score. Tap any of the six Braden risk categories to open the Risk Detail screen and 
select the appropriate risk levels. Selecting a risk level will bring up a description of that risk level that will assist in selecting the 
appropriate level. The Braden Scale requires a risk assessment for each of the six categories. If a category is not entered, the Score 
evaluates to 0, which should be taken as meaning the Scale is not in use.
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Diagnosis Risk screen

On the Risk Detail screen, choose values for all six categories. Select Prev  or Next  to navigate between the 

Details screens, or select Finish  once all categories are specified.

Risk Detail screen

When leaving the Risk screen by selecting Next  the following screen will either be Surface Equipment or Summary 
Review. The Surface Equipment screen is activated when in the context of creating a new assessment, or when a surface has been 
selected for review. Otherwise the Summary Screen is activated.

Seite 10 von 64Medical Modes: Basic and Advanced

29.01.2015file:///C:/Users/dm/AppData/Local/Temp/~hh92FD.htm



Surface Assessment
Assessment of a seating surface begins with selecting equipment on the Equipment screen. This may involve particular cushions, 
backrests, and wheelchairs. A Position indication screen allows the recording of details about body positioning in the seating 
configuration (cushion, backrest, wheelchair) being reviewed. The Imaging screen provides steps for generating a consistent pressure 
image. This screen is only present when assessing a new surface, otherwise it is replaced with a Review screen.

Surface: Equipment
The Equipment screen records the seating equipment in use for a particular surface. The three types of equipment represented are 
seating cushions, backrests, and wheelchairs.

Although the Brand and Model fields hold a variety of equipment for selection, it is possible to add more equipment to the lists. Tap New
to open the Add to Catalog screen and add equipment for a particular type. If adding a model to an existing brand, first select the Brand 
before tapping New. This will carry the Brand name into the Add to Catalog screen. Added equipment will appear in all subsequent 
seating evaluations, so it is not necessary to enter this equipment information repeatedly.

If a particular type of equipment is not in use, either leave the Brand and Model fields blank, or select None in the Brand field.

Surface Equipment screen
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Add to Catalog screen

Surface: Position
Use the Position screen to indicate the placement of various parts of the body. Tap the body part name to activate its panel, which 
contains a list of possible positioning descriptions. Some of the details are represented by orientations that can either left or right only. 
Select the circle representing this left or right orientation. 

Surface Position screen

Once done with setting the selecting the Equipment and indicating the position of body parts, select Next to activate the Imaging or 
Review screens.

Surface Assessment: Imaging and Review
The Surface Imaging and Review screens shows the pressure image of the seating surface. The Imaging screen is used to create the 
pressure image, while the review screen is for review.

Surface Imaging

Surface Imaging consists of three stages that involve positioning the client on the sensor, placing markers to identify key areas of 
pressure (bony prominences), and recording the pressure image. 

Imaging: Setup
The first stage of Imaging involves positioning the client on the sensor, such that the best use of pressure sensing area is made and so 
the pressure image shows the contact area made by the patient on the cushion.

Start by adjusting the client so they are centered in the pressure image. Next, if required, rotate the pressure image (using the rotate 
button) such that the back of the person is at the bottom of the screen, and their knees are towards the top.
To adjust the upper pressure threshold, click on the up or down arrows on the pressure scale next to the word "Instructions" on the right 
side of the screen. 

Identify the location of the bony prominences (ITs, GTs and coccyx) and mark them with the markers shown. The center of a marker 
should be over the center of the area you want to highlight. By doing this, the software will calculate the Peak Pressure Index (PPI) at 
the location of each identified prominence. Take care in placing the markers, as they cannot be moved after the next screen in the 
assessment, patient settling time, is shown.
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The pressure scale can be changed to better highlight areas of high pressure. Adjust the scale by tapping the arrows on the scale 

 widget.

Select Next  to move to the Settling stage, or Cancel  to stop the assessment.

Surface Imaging in the Setup stage

Imaging: Settling
The Settling stage allows the patient to settle into their normal seating position, and for the surface on which the patient is positioned to 
compress under their body. A timer counts down the remaining settling time. However, at the operator's discretion the timer can be 
bypassed using the Next button. This should only be done if it appears the surface has reached a stable shape, or if the patient has 
already settled into their normal seating position. (The timer duration is set in the Database Options screen.)

The Recording stage begins when either the settling timer reaches zero, or Next is selected.

The pressure image can be hidden while in the Settling stage so as to reduce any client movement caused by their ability to see the 
screen.
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Surface Imaging in the Settling stage

Imaging: Recording
The Recording stage collects the pressure data used to form the assessment statistics. During this stage the client should remaining 
fairly still as any movement will impact the statistics collected. If the X3 DISPLAY's screen is visible to the client, then the pressure image 
should be hidden to prevent any sort of seating adjustments caused by feedback from the screen.
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Surface Imaging in the Recording stage

Surface Review
The Surface Review screen displays the averaged pressure image from the Recording stage. The contact area and average pressure 
are shown, along with the Peak Pressure Indices (PPI) of any placed markers. For any particular marker, the sensels used to evaluate 
the PPI can be seen by tapping the marker icon.

When the two ischial tuberosity markers are present, the Show Symmetry option will attempt to generate a line of symmetry. A light gray 
line through the pressure image represents the "perfect" line of symmetry, while the red line with white dots represents the amount by 
which the centers of gravity are off from the ideal. The white dots at the ends of the red line should be ignored as they tend to be skewed 
by an absence of pressure data.

A page of notes pertaining to the assessed surface can be entered by selecting the Notes button.

If for some reason there is a problem with the pressure image (e.g. if the client moved), then the surface can be discarded from the 
assessment by selecting Discard.
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Surface Review after Imaging

From the Review screen, select Next to go to the Summary Review screen.

Assessment Summary

The Assessment Summary shows all of the surfaces on an assessment. New surfaces can be added, and existing surfaces can be 
marked as recommended. An assessment report can be generated and either saved as a PDF, or printed directly.

Summary Review
The Summary Review screen lists all of the surfaces assessed in an assessment. The statistics for each surface are shown, and the 
values that are best across all the surfaces are highlighted in green.

To review a surface in detail, select it by tapping the surface image. New surfaces can be evaluated by selecting the Next Surface button.

One or more surfaces can be marked as Recommended, tap the checkbox below the surface statistics. Enter a page of notes pertaining 
to the summary via the Recommendations button. These notes and the Recommended checkmarks will appear in the Assessment 
report.

Select the Report button to view the Assessment report, or the Finish button to return to the Client Assessments screen.
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Summary Review showing the surfaces of an Assessment

Summary Report

The Surface Assessment report is a multi-page report for a single seating assessment. The report sheet can either be printed to any 
PCL compliant USB printer via the X3 DISPLAY peripheral cable, or saved to the active storage card in PDF format.
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Report Screen Widgets

Since the report is normally larger than the viewing area, it can be fit to different scales. The Fit Page button scales the image 
to completely fit in the viewing area. This shows the least detail, but gives a quick overview of the page layout. The Fit Width button 

scales the image so that the width of the page takes of the width of the viewing area. This is the default view and offers a 

good tradeoff between viewing detail and page layout. Finally the Fit Actual button shows the image nearly to the scale of the 
actual printed page.

If the report contains two or more pages, these can be navigated by tapping the page arrows,  and .

To exit the Report View, select the close button .

Printing the Report

Select the print button  to send the report to a printer. A warning message appears if no printer is attached, and the print is 
canceled. Otherwise, the printer selection window should appear.
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Printer Selection Window

On the printer selection window, specify a printer and select OK to print.

Saving the Report to Adobe PDF

Select the Save PDF button  to save the report in the Adobe PDF format. The saved PDF can be given a unique name, though 
by default it is named by the software.

Creating Sessions

Pressure data collected with the XSENSOR system is stored in a custom file format. These files are referred to as sessions and have an 
XSN extension.  Besides pressure data, session files can also contains notes, attached images, and video frames. A session file 
represents a particular sensor recording configuration. Changing the configuration requires creating a new file. Sessions are configured 
either automatically by the software or manually by the user.

Session files are either be managed or unmanaged.  Managed sessions are created inside session folders, while unmanaged sessions 
are stored in other locations on the computer.

Automatically configured sessions: 
The XSENSOR software checks for the presence of sensors on startup.  If any are found, then a new session file is created using all of 
them.  The session is also configured for recording using the default settings.

The New  toolbar button and the <Ctrl+N> keyboard shortcut also automatically configure a new session file when sensors are 
detected.  (If no sensors are detected, then the New Session window is opened.)

Manually configured sessions: 
A new session can be manually configured via the New Session window. To open this window either Choose New from the File menu, or 
right-click a session folder and choose New Session.
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New Session window with one detected sensor and default recording settings.

The Sensor Configuration list shows all of the sensors detected by the software. This list should update automatically as sensors are 

connected and disconnected from the computer. The Refresh List button  (or press <F5>) can used to manually refresh the list. 
Sensors in the configuration list are identified by the model type and serial number. A checkbox beside the sensor indicates whether the 
sensor should be included in the new session file. Uncheck the sensor (using left click) to remove it from the configuration.

A column labeled "Active Pressure Range" shows the default pressure range for each sensor. The pressure range can be changed by 
selecting the existing range. A drop-list arrow appears and a new range can be selected. The range "Uncalibrated" represents a raw 
recording session. Any combination of pressure ranges can be selected, however, once "Uncalibrated" is selected for one of the sensors 
the entire session is treated as uncalibrated.

Selecting a pressure range.

The configuration lists order represents the order in which the selected sensors appear in the various viewing modes and graphs. To 

change this order, select a sensor and click the Move Up  or Move Down  buttons (or press <Ctrl+up arrow> or <Ctrl+down 
arrow>).

The Calibration Manager button opens the Calibration Manager window which is used for advanced management of calibration files and 
pressure ranges. 

Look here for a description of the Basic and Advanced recording tabs.

The Other Settings tab is used for specifying some non-recording settings. 

Use the Sensor Group Template field to specify a sensor group template.  The templates are a convenient way to reuse pre-made 
sensor groupings. 

Use the Notes Template field to specify a default notes template. 
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Basic Recording Options

The basic recording options control how fast and how long a recording session lasts. These settings define a session configuration and 
cannot be changed within a session file. To use new settings, manually create a new session file. This tab appears in the New Session
window.

The Basic Recording tab.

Basic Recording tab:
Use this tab to set the recording speed and the session duration. 

In the Recording Speed group, use these fields to select a recording speed. This can be set as slow as one frame per minute, or it 
can be set to the fastest speed of the slowest sensor in the Sensor Configuration list. 

The recording speed field automatically selects the maximum recording speed for the configuration if a speed greater than the 
maximum is entered.
The SPK Performance field affects the maximum possible sampling rate. The Recommended setting is in fact recommended. Click 
here for more information.

In the Recording Duration group, use these fields to set the recording duration as either a period of time or a given number of 
frames. The duration is limited by the size of the file that results from the Sensor Configuration and recording speed. The duration is 
automatically adjusted to ensure the maximum memory use is not exceeded. 
The recording duration refers to a recording session and not the entire session file. Each time the record button is pressed, this 
duration is reapplied. For example, with a recording duration of 90 minutes a session file could have 180 minutes of total recording 
time split across two recording sessions.
Tip: Select slower recording speeds to maximize recording times and reduce memory consumption.  Keep file sizes to under 200 
megabytes to ensure best responsiveness in the software.

The Estimated Recording Time/File Size field shows the expected duration and file size generated by a recording session (i.e.: 
pressing the record button). This size does not take into account other items that increase memory usage, like video capture, image 
attachments or text notes. 
NOTE: The software will halt recording if at any point the total computer memory usage reaches 80% or greater. This is to prevent 
low memory conditions that might result data loss or corruption.

Advanced Recording Options

The advanced recording options provide control over when recording begins. These options also affect some of the recording behaviour 
and screen refreshes. The advanced recording options can be set on the Advanced Recording tab in the New Session window, and on 
the Playback/Recording tab in the Options window.

The Advanced Recording tab in the New Session  window.

Seite 21 von 64Medical Modes: Basic and Advanced

29.01.2015file:///C:/Users/dm/AppData/Local/Temp/~hh92FD.htm



The Advanced Recording group in the Playback/Recording option window.

Recording Preview Mode:

The Recording Preview Mode is useful for positioning a subject on a sensor before committing pressure data to a session file. When 
previewing, the pressure image from the sensors is displayed without using memory. 

When this mode is selected, the Record Frames  button is replaced with the yellow Preview Frames  button.  Clicking the 
yellow button (or press <F8>)  starts the preview mode, and the button is replaced with the Record Frames button.

Time Compensated Calibration:

Select Enable Time Compensation to apply an adjustment factor to the recorded data that takes into account the passage of time. 
This feature can produce more accurate readings over time, but is only available for sensors that have been time calibrated. 

Select Physically Overlapping Sensors to reduce any signal cross-talk that might occur when two or more sensors are used to 
gather readings from a single pressure source. For example, a seat sensor and a back sensor on a chair with some overlap of the 
sensors. Due to the nature of this feature, the sample rate can be impacted and may decrease. 

This mode is applied to all open sessions when enabled. 
Note: This option only appears in the Playback/Recording options tab..

Other:

Use the Display Refresh Rate drop-down list to change the rate at which the screen refreshes when recording a session. Higher 
refresh rates produce smoother display updates, but requires more processing.   This increased processing requirement can interfere 
with the recording rate. The default rate is 5Hz. 
Note: This option only appears in the Playback/Recording options tab..

See Also:
Setting playback/recording options

Recording a session

After a sensor system has been connected to the computer and a session is created, recording can begin immediately. The basic
recording settings, such as speed and duration, are specified when a session is created. The advanced recording settings can be 
modified at anytime.

To record a session:
1. Either create a new session, or open an existing one. When opening an existing session file, any new frames are appended to the 

end of the file. 

2. When the Preview Mode is active, the Record Frames button turns yellow . Click this button to view live sensor images without 
recording them. 

3. To start recording, click the Record Frames  toolbar button, or press the <F8> key. 

4. To stop recording, click the Stop Playback/Recording  button, or press the <Spacebar>. 

Note: The Record Frames button is disabled if the session file is read-only. 

See Also:
Setting playback/recording options
Viewing recorded frames
Viewing session statistics

Recording with Video Capture

The software has the ability to capture video images from any compatible USB web camera or Firewire Digital Video (DV) camera. Video 
is generally recorded at a rate of one video frame per frame of sensor data. If the sensor recording rate is faster than the video camera, 
then the previous video frame is used until a new frame is available.

A video device is configured via the Video Capture Options tab. This must be done before any video capture can occur. The Video 
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Image window shows the video imagery, and is used to turn video recording on and off.

Note: To show the Video Image window, select Show Video Image Window from the View / Toolbars menu. By default this 
window is docked next to the Images window.

The power button  is used to toggle the camera on and off.

When the camera is toggled on, the Video Image window shows a live feed from the camera. If no video has yet been captured, then the 
live feed covers the entire Video Image window. The label LIVE appears in the lower right corner of the image.

Once session recording begins, the live feed is replaced with the video frame that is captured with the pressure image. The label REC
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appears in the lower right corner to indicate the image is being recorded.

When a recording session ends, the live video feed appears in a small box over top of the recorded video. This is useful for repositioning 
the camera for the next session.

Video frames can be removed using the video removal  button. This is covered in more detail here.

Video Capture Options

These options are only available in the Advanced medical mode. Look here for the Basic mode options.

Use the Video Capture tab in the Options window to detect video devices, control image compression and quality, and to specify device 
settings. Video devices are automatically detected when the XSENSOR software starts up, though if none were previously selected then 
a camera must be manually specified.  

NOTE: Any changes to these settings will not take affect until the camera has been shut off via the Video Image window.

Camera
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Select a camera from the top list or press Detect to search for any cameras that were connected after the software was started. Some 
cameras have extra input ports allowing for multiple video sources. In those cases, the Video Input Source field is activated and the 
most appropriate selection should be made from that list.

Configure Camera
The Configure Camera option opens the camera manufacturers settings windows for the camera. These windows may vary depending 
on the manufacturer. Below are two common windows.

\

XSENSOR recommends using the default settings presented by the manufacturer. However, experimentation with these 
settings may result in improved video image quality.

Image Settings 
The Image Format lists shows the video formats made available by the camera manufacturer. The first two numbers specify the pixel 
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resolution of the image (in the image above, it's 320 pixels wide by 240 tall). The third number specifies the color resolution. The higher 
the number the better the color resolution. However, there is no difference between 24 and 32 and using 32 only results in greater 
memory use. The final tag in brackets is the color format. If possible select an (RGB) format as the software natively handles video 
images in that format and will not incur a format conversion penalty. If (RGB) is not available, experiment with some of the other available 
formats to find one that gives the best performance.

NOTE: To reduce memory use and processing requirements, choose the lowest pixel and color resolution that gives acceptable 
results.

Select Stretch to fit display window to stretch the video image to fill the Video Image window. Otherwise leave this off to maintain the 
original aspect ratio.

Use the Image Compression/Quality slider bar to set a balance between compression and image quality when recording video images. 
Better compression reduces the file size requirements for each video image, but reduces image quality. Likewise, the highest quality 
setting provides almost no compression and requires the most file space per image, but preserves the highest image quality.

Other Options
Basic Medical options
Setting 2D/General Display options
Setting 3D options
Playback/Recording options
Program options

Zero Pressure Filter

The Zero Pressure filter is used during recording to set a zero reference that reduces the effects of the environment when no pressure is 
being applied to a sensor. This function affects the recorded data and should be used with care. To enable the filter, begin recording, 

ensure the sensor has no pressure on it, and then select the Zero Pressure Filter  toolbar button.

Viewing sessions in different modes

Session data can be viewed in a variety of ways that include 2D and 3D representations, and as graphs.
These modes can be switched via the View menu, or by the Display Mode Toolbar.

Click the links below to find out more about the different viewing modes.

2D View - Basic

The basic 2D view is the default viewing mode.   This view shows a 2D representation of the recorded sensor pressure. The numbers 
across the top and sides of the 2D image correspond to the numbers printed along the edges of the sensors. Some of the more common 
features used with the 2D view include viewing the pressure values associated with the isobar colors, and copying pressure data directly 
from the view into the clipboard.

To enter the 2D view mode, from the View / Current View menu and choose 2D View, or click the 2D View  toolbar button.

2D View

2D Numeric View

3D View

Pressure Distribution graph

Pressure vs Time graph

Multi-View mode
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The 2D viewing mode can be configured to display images in a variety of ways. See 2D Options for more information.

View Pressure Values
One of the simpler methods of viewing the pressure values behind the colored isobars is to hold the left mouse button down and drag the 
mouse around the sensor. The pressure under the mouse is shown in the middle of the status bar. Another method involves enabling the 
2D Numeric View which shows the numbers directly over the pressure image. A third method is via the 2D Magnifier window.

Clipboard Copy
A region of pressure data can be copied directly from the 2D view into the clipboard. While holding the <SHIFT> key down, press the left 
mouse button and draw the mouse pointer to form a selection rectangle. The region in the rectangle will show inverted colors. Release 
the left mouse button and the inverted rectangle will remain. Use <CTRL>+C to copy the sensels. The copied data can be pasted into 
any text editor or spreadsheet program.

Basic Medical options
These options are only available in the Basic medical mode. Look here for the Advanced mode options.
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Basic Medical mode options

Image Settings
The Quality and Performance options change how the 2D and 3D views are rendered. Quality gives a better looking image at the 
expense of a slower frame rate during playback. (In some instances, the recording playback may also be reduced.)

Low Pressure Color
The Low Pressure Color setting controls the color used when drawing sensor cells that fall below the pressure range supported by the 
sensor. The Normal option draws those cells with a dark blue color. The Clear option draws those cells in white. Use the Clear option to 
better see those cells that fall near the low end of the pressure range.

3D: Surface Direction
Changes the direction in which increasing pressure travels from the plane of the sensor. The positive direction causes higher pressure to 
rise up (like a mountain). The negative direction causes higher pressure to sink down (like a valley).

Playback: End of Session
These options control what happens when during playback when the end of the file is reached. Loopback rewinds to the beginning of the 
file and continues playing. Stop causes playback to end and remain on the last frame.

Recording
The Preview Mode is useful for positioning a subject on a sensor before committing pressure data to a session file. When this mode is 

selected, the Record Frames  button is replaced with the yellow Preview Frames  button.  Clicking the yellow button (or press 
<F8>)  starts the preview mode, and the button is replaced with the Record Frames button.

Select Time Compensation to apply an adjustment factor to the recorded data that takes into account the passage of time. This feature 
can produce more accurate readings over time, but is only available for sensors that have been time calibrated.

Units & Formats
Change Surface Area units with this list. Options include square inches and square centimeters. The date and time formats can also be 
modified.

Setting 2D/General Display options

These options are only available in the Advanced medical mode. Look here for the Basic mode options.
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Use the 2D/General Display tab in the Options dialog box to control the appearance of the 2D viewing mode. To open the Options
dialog box to this tab, from the Options menu, choose 2D.

The 2D Settings option group is used to set controls for the 2D view. The Display Settings box is used to set controls for all viewing 
modes. 

To set 2D options:
Click the links below for more information about the options in this option group:

Surface Type:

Grid Overlay:

Other:

Group Transparency:

To configure display settings:

Display Resolution:

Low Pressure Color:

Isobar Palette:

Threshold Values:

Other Options
Basic Medical options
Setting 3D options
Playback/Recording options
Program options
Video Capture Options

Sensor Orientation

When working in the 2D and 3D  viewing modes, a sensor can be rotated, and flipped vertically or horizontally. This enables optimal use 
of the available screen space and also allows aligning the pressure image with the physical orientation of the sensor.

Rotate a sensor

Click the Rotate Active Sensor  button to rotate a sensor 90 degrees clockwise.
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Flipping a sensor

Click the Flip Sensors Vertically  button to flip the image vertically, and the Flip Sensors Horizontally  button to flip the image 
horizontally. These two buttons are found under the Rotate Active Sensor drop list.

Rotate Active Sensor drop list.

The rotate and flip functions only operate on the active sensor. When working with a session that includes multiple sensors, the active 
sensor is indicated under the Active Sensor menu which appears via the Rotate Active Sensor drop list. Use this menu to change the 
active sensor, or alternatively in the 2D viewing modes, the active sensor can be changed by left clicking on a sensor.

The row and column labels normally stay in the left and upper sides of each sensor. This behaviour can be modified to allow rotation and 
flipping of the labels. Use the Rotate Row/Column labels option in the 2D/General Options window.

Orientation Marker
When working in the 2D view, an orientation dot in the corner of the image corresponds with the top-left hand corner of the sensor 
(column 1, row 1). This dot serves as a reference point when rotating or flipping the on-screen image. It also indicates the active sensor. 
The marker can be toggled on or off via the Orientation Marker option on the 2D/General Display window.

2D Numeric View 

The numeric 2D view overlays pressure numbers over the isobar colors. Only pressure that is greater than the lower threshold is shown. 
Normally the text is very condensed and so a zoom mode can be accessed to better see the numbers.

2D View in numeric mode - very condensed pressure numbers.
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2D View in numeric mode - zoom mode is activated.

The numeric viewing mode is activated via the menu View -> Current View -> 2D Numeric View, or by the 2D View Modes toolbar drop-

list and selecting the 2D Numeric View  button.

Center of Pressure Indicator

The center of pressure indicator shows the spot on a sensor where the surrounding accumulated pressure is equal in all directions. 

Click the Center of Pressure  button to toggle the indicator. This button is located under the View menu.

2D Zoom Mode
The 2D Basic and Numeric views support a zoom feature that allows magnification of the pressure map for better viewing. The zoom 
feature can be activated by scrolling a mouse-wheel, or by holding the <CTRL> key and the left mouse button and dragging a selection 
rectangle.
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2D View in numeric mode - zoom mode is activated.

While this feature is active, a zoom control window appears in the lower right corner of the screen. The zoom window shows a thumbnail 
of the sensor configuration, and the current view is highlighted by a rectangle. The highlight rectangle can be moved around the 
thumbnail by either selecting a movement arrow button, or by left clicking and dragging it.

The level of zoom is controlled by either scrolling a mouse-wheel or by selecting the slider bar on the right.

To exit the zoom mode, press the Full View  button.

2D Magnifier window

When working in the 2D viewing modes, it can be convenient to examine portions of the pressure image in detail. To do this either the 2D 
zoom mode can be activated, or more simply the Magnifier window can be opened.

To open the Magnifier window, right click on the pressure image. A small window appears with 9 sensels. The corresponding sensels are 
also highlighted on the 2D image. The highlighted area can be moved by right clicking else where on the 2D image. If the right mouse 
button is held, the mouse can be dragged to smoothly update the magnifier window.

Magnifier window.
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Window Size
The number of sensels shown in the magnifier window can be changed by resizing it. Position the mouse pointer over one of the sides or 
corners of the magnifier window so that the pointer changes to a line with two arrows . Click and drag a window edge to increase or 
decrease the sensel selection as desired.

Sensel Formatting
The sensel dimensions and font used in the Magnifier can be changed. To change the dimensions right-click in the window and choose 
Change Size. Move the Width or Height slider bars to adjust the size of the sensels. Similarly choose Change Font and select a new 
font. To reset the size and font of the sensels select the Defaults option.

Clipboard Copy
The displayed sensel pressures can be copied to the clipboard. Right-click on the window and select Copy to Clipboard. These values 
can be pasted into any text editor or spreadsheet program.

3D View

Choose this mode to view the current session as a three-dimensional pressure contour, as shown below. The pressure from each sensel 

defines the 3D height. To enter 3D viewing mode, choose 3D View from the View / Current View menui, or click the 3D View
toolbar button.

The size, orientation and position of the sensors can be changed using the mouse and the 3D settings icons. The icons are only present 
3D Tool Icons is selected in the 3D option window.

 The 3D view can be configured in a variety of ways.

Setting 3D options

These options are only available in the Advanced medical mode. Look here for the Basic mode options.

Use the 3D tab in the Options dialog box to control the appearance of the 3D viewing mode. To open the Options dialog box to this tab, 
from the Options menu, choose 3D.
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To set 3D options:
Click the links below for more information about the options on this tab.

Surface Type:

Surface Direction:

Background Color:

Renderer:

Other:

Other Options
Basic Medical options
Setting 2D/General Display options
Playback/Recording options
Program options
Video Capture Options

Changing the 3D View

When working in the 3D view, the size, orientation and position of the sensors can be adjusted using the mouse and the 3D Tool icons. 
The tool icons are only present when 3D Tool Icons is selected in the 3D option window.Consult the table below to see how each tool 
works.

Click this icon...
To do this
Click the Rotate icon to rotate the image horizontally or vertically. Place 

the hand pointer  on the image, click and hold the left mouse button, 
and then move the pointer back and forth (or up and down) to rotate the 
image along the horizontal or vertical planes. Note: This icon is active by 
default when entering the 3D viewing mode.

Click the Zoom In/Out icon to increase or decrease the size of the image. 
Place the hand pointer on the image, click and hold the mouse, and then 
move the pointer back and forth (or up and down) to zoom in or out.
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3D Chair Configuration mode

This 3D-only mode is used to orient a two sensor system such that it appears as a chair with a 90 degree back. The mode expects the 

first sensor in the configuration to be the seat and the second to be the back. To enter the mode, select Chair Configuration  from the 
View / Current View / 3D Modes menu.

Note: This mode is only available when working with a two sensor configuration.

Pressure vs Time Graph

The Pressure vs Time graph plots pressure or contact area along the Y-axis and time across the X-axis. The plotted values are 
generated from sensors or sensor groups.

Show this graph by selecting Graph: Pressure vs Time from the Graph menu, or click the Pressure vs Time  button found in the 
Display Mode and Graph Mode toolbars. 

Click the Height icon to adjust the relative height/depth of the peaks and 
valleys in the image relative to the x-y plane. Place the hand pointer on 
the image, click and hold the mouse, and then move the pointer up and 
down to move the peaks up or down.

Click the Move icon to move the image around within the 3D view. Place 
the hand pointer on the image, click and hold the mouse, and then move 
the image to the desired position. The right mouse button also provides 
this functionality.

Click the Reset Default Position icon to reset the 3D view to the default 
settings.
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Pressure vs Time graph with pressure plots for two sensors and a sensor group.

Change the settings for this graph via the Graph Settings tab or by right clicking on the graphing area. 

Subsets of the Pressure vs Time graph can be selected with the graph zoom feature. 

When the Pressure Legend option is selected, a legend appears showing the graphed elements and the pressure or area value for 
the current frame. 

A grey vertical line indicates the beginning of each recording session within an session file. 

A black vertical line marks the current frame position. The current frame can be changed by clicking and dragging this line with the 
mouse, or using the keyboard left and right arrows. 

The horizontal lines are pressure indicators used as visual aids in interpreting the graph. These lines can be moved by either clicking 
and dragging with the mouse, or by double-clicking a line and editing the pressure numbers directly in the Indicators window (see 
below).  The solid light gray line is the base indicator, and the dotted and dashed lines are the upper and lower indicators 
respectively.

                Pressure vs Time Indicators Editor

Tip: The current range of frames can be easily selected for export.  Right click the graph and select Export Graphed Frames from the 
popup menu.

Pressure vs Time Zoom Feature

The Pressure vs Time graph normally shows all frames along the X-axis and the full pressure range along the Y-axis. A zoom feature 
allows for graphing of a subset of the session frames and pressure range.

Seite 36 von 64Medical Modes: Basic and Advanced

29.01.2015file:///C:/Users/dm/AppData/Local/Temp/~hh92FD.htm



Viewing a Frame Subset
To zoom in to a subset of frames, leaving the pressure range unchanged, move the mouse pointer over the subset start frame, hold the 
<SHIFT> key and press the left mouse button. Drag the mouse to the subset end frame and release the mouse button.

Viewing a Pressure Range and Frame Subset
To zoom in on a subset of frames and pressure range, move the mouse to the subset start frame and pressure, hold the <CTRL> key 
and press the left mouse button. Draw the mouse to the subset end frame and pressure and release the mouse button.

NOTE: The zoom selection can be canceled by either pressure the right mouse button, or by releasing the <CTRL> or <SHIFT> 
key before the left mouse button 

To restore the frame and pressure ranges, right click on the graph and select Show All. The Zoom Out option is used to show 
increasingly larger ranges.

The Y-axis pressure range can be adjusted by holding the pointer over the graph, and using the mouse wheel to adjust the upper 
pressure, or hold <SHIFT> and use the wheel to adjust the lower pressure.

Click here to see an example

Pressure Distribution Graph

This graph is used to view the pressure distribution of the current frame.   The graph can display individual pads, the average of all pads, 
and sensor groups.
The pressure distribution graph shows the number of occurrences of sensor readings within set pressure intervals. Each interval is 
represented by a bar, and the height of the bar is the relatively percentage of readings within the interval. For example, if 100% of the 
cells of a sensor fall within a pressure range, then that bar appears as the maximum height while all other bars are not drawn.)   The 
pressure range can be split into 1 to 250 intervals...
To display the Pressure Distribution graph, from the Graph menu, choose Graph: Pressure Distribution, or click the Pressure 

Distribution  toolbar button.

In the example above, the first bar shows the occurrence of sensor readings between 5 mmHg (the threshold) and 31 mmHg to be 
71.09%.  Therefore 71.09% of the sensors for frame 1 are within the range of 5 and 31 mmHg.  The next bar indicates that 17.97% of the 
sensor readings are between 32 and 59 mmHg, and so on.

Graphing a Selected Pressure Distribution Interval

The Pressure Distribution graph normally shows the entire pressure range along the X-axis.  A smaller subset of the range can be 
viewed.

To display a smaller range:

To show the full interval
Note: The pressure interval can also be specified in the Plot Distribution Subset option group on the Pressure Distribution options 
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tab.

Graph Settings

Use the Graph Settings window to change how the various graphs are displayed.

General

Pressure Distribution

Pressure vs Time
Tip: After selecting one or more options on any of these tabs, click Apply to see the changes without closing the Graph Settings
window.

General Graph settings

Colors are assigned to each sensor based on its configuration order. To change a color, left click in the color box and chose a new 
color. 

The Average Sensor color is averaged sensor generated for the Pressure vs Time and Pressure Distribution graphs. 

Click the Restore Default Colors button to restore the default colors for all sensors.

Pressure Distribution Settings

Use this tab to configure the Pressure Distribution graph.

Pressure Distribution settings

Graphed Items

Num. Bars (X-axis)

Percentage Range (Y-axis)

Plot Distribution Subset

Miscellaneous

Tip: When working with the Pressure Distribution graph, many of the settings can be accessed by right-clicking the graph.
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Pressure vs Time Settings

Use this tab to set options for the Pressure vs Time graph.

Pressure vs Time graph settings.

Graphed Items

Graphed Value

Pressure Indicators

X Axis: Pressure vs.

Graph Frame Window

Tip: When working on the Pressure vs Time graph, all of these settings can be quickly changed by right-clicking the graph and 
using the popup menu (shown below).

Pressure vs Time graph right click menu.
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Multi-View mode

Use the Multi-View mode to display the current frame in up to four different views at once. This mode is activated by selecting Multi-

View Mode from the View / Current View menu, or by the Multi-View Mode  toolbar button.

This illustration shows the Multi-View Mode view with three panes configured.

Multi-View Configuration
The Multi-View mode is configured through the Multi-View Configuration window. To open this window, select Multi-View Config from 
the View / Current View menu.

The number of panes and layout is selected by the Layout Options drop-list. Each pane has a drop-list of available views that can be 
shown. A view can only be present in one pane.
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Multi-View Configuration window showing three configured panes.

Comparing Files

Use the Compare Files mode to compare frames from two to four open session files. While in this mode, the display mode settings and 
frame navigation tools are synchronized across the compared files.  Playback can also be synchronized when the Link Compare Mode 
Play option is enabled. The pressure legend is split to show the distributions of the compared sessions.

To use this mode, open or create up to four sessions and select Compare Files  button found under the Tools menu.  If more than 
four sessions are open, the Compare Open Documents window prompts for the sessions to compare.
In Compare Mode, only one session is active and accepts frame navigation commands.  To activate another session, click the session 
title bar or within the session view.  By default, the top left corner is active when Compare Mode is turned on.

Comparison of four sessions.
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To exit the compare mode, either select the Compare Files button. The mode is also exited when a session file is created or opened.

Comparing Frames

The Frame Compare mode is used to visually compare up to four frames from within the active session file. This mode is activated by 

selecting Compare Frames  from the Tools menu. Exit the mode using the same method.

When the Frame Compare mode is first activated, the Select Compare Frames window appears to allow up to four frames to be 
selected for comparison. The candidate frames can be selected by using the slider bars or by directly entering the frame number.

NOTE: The candidate frames are rendered in a low resolution to improve selection speed.

Selecting four frames for comparison.

NOTE: Recording and playback are disabled while in the Frame Compare mode.
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Viewing four frames.

Merge Frame Mode

The Merge Frame Mode creates a composite pressure image from a selected range of frames. The composite image is created by either 
averaging the selected frames together, or by picking the peak pressures across the range.

The frame created by this mode is temporary and is for visual inspection only. However, the pressure data can be extracted using the 
clipboard copy method. Alternatively the export function can be used to generate an averaged frame.

This mode is toggled on and off via the Merge Frame Mode  entry under the Tools menu.

Setting up the merged frames.

Navigating Frames

Navigation of recorded frames can be accomplished in a number of ways.  The primary method is the Frame Control Toolbar.

Using the Frame Control Toolbar:

Using the Go to Frame window:

Using the keyboard:

Using the Pressure vs Time Graph Frame Marker:

Using the Notes: All Frames window:

Playback/Recording options
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These options are only available in the Advanced medical mode. Look here for the Basic mode options.

Use the Playback/Recording tab in the Options dialog box to control playback behaviour and to change advanced recording options.

Play Rate

End of Session

Display Frame Time

Link Compare Mode Play

Advanced Recording

Other Options
Basic Medical options
Setting 2D/General Display options
Setting 3D options
Program options
Video Capture Options

Pressure Thresholds

Use the Lower and Upper Discard Thresholds to eliminate potential sources of noise. Pressure readings below the lower threshold and 
above the upper threshold are treated as zero. These thresholds only affect the calculation of statistics and the display of pressure data. 
Changing the thresholds does not affect the saved pressure data.

The default lower threshold for new sessions is the minimum pressure supported by the calibration range. If a higher Lower Discard 
Threshold pressure is selected, any new session will use it. If a pressure below the calibration range is selected, then any new sessions 
will default to the minimum calibration pressure. By default the Upper Discard Threshold is off. This can be enabled via the Thresholds 
window or in 2D/General Options

The Thresholds window is activated either via the View / Pressure Threshold  button, or by left clicking the Pressure Legends 
range bar.
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The Pressure Legend Maximum field affects the displayed maximum pressure of the Pressure Legend. Changing this field affects the 

active sensor (if opened with the Pressure Threshold  button), or the sensor associated with clicked the Pressure Legend range 
bar.

NOTE: Changing the discard thresholds affects all statistics computed by the software. This is particularly computationally 
expensive for the Pressure vs Time graph because the entire graph must be regenerated when the thresholds are changed. For 
very large files, regenerating the graph data may take minutes.

Pressure Legend

The Pressure Legend shows the distribution of sensels across a fixed number of isobars. Its also used as a color reference for viewing 
the pressure image in the various viewing modes. 

The values in the left column denote the start pressure for each isobar.  The colored isobars represent a range of pressure values from 
the start pressure to just under the start of the next highest isobar.  The top (typically red) isobar spans all values at and above its start 
pressure.  The right column values denote the distribution of sensor cells (sensels) that occur in each isobar. For example, in the image 
below, there are 187 cells that lie between 10 and 22.67 mmHg.

The legend header shows the pressure units (in this case mmHg).  The pressure units can be changed by left-clicking the units label and 
selecting a new unit from the list.  (See Figure 2.)  Two arrows in the header change the legends upper pressure in steps of 1% of the 
maximum pressure.  (In this case the total range is 200 mmHg, hence the step is 2 mmHg.)  The upper pressure can be changed by 
moving the mouse pointer over the legend and spinning the mouse wheel. Another method of changing the upper pressure is to click on 
a colored isobar. This cause the isobar pressure to become the top pressure. To restore the full scale range, click the top isobar. The pin 
button in the header is used to link multiple legends.  Linked legends share pressure range changes.

The legend footer shows the pressure range (in this case 10 to 200 mmHg).  The lower pressure is a threshold under which any sensor 
readings are considered to be zero.  The lower pressure can be changed in steps of 1% of the maximum pressure.  

The legend footer shows the pressure range currently active. The upper number is associated with the legend's maximum pressure. The 
lower number is associated with the lower discard threshold. A single click in the footer opens the threshold window.

The pressure cannot go outside the range defined by the calibration settings.  For example,suppose a sensor is calibrated from 10 to 200 
mmHg, the lower pressure cannot be less then 0 mmHg and the upper pressure cannot be greater than 200 mmHg.

NOTE: To show the Pressure Legend, select Show Pressure Legend  from the View / Toolbars menu.
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Session Properties

The Properties window shows information about the session file, including the sensor configuration, recording rate, recorded session 
statistics, and calibration details. To open this window, select Properties from the File menu.

Statistics window

The Statistics window displays statistical data for the active session file. The window can show statistics for individual sensors or for 
sensor groups. The different statistics are split across columns. Each row contains the statistics for a single sensor or sensor group. The 
first column shows the sensor or group name. The other columns vary depending on which statistics are selected in the Program Options
tab.

The font used to display the statistics can be changed for easier viewing. Right click the column labels in the Statistics window and 
select Change Font. The original font can be restored with the Defaults option.

Clipboard Copy
The entire contents of the statistics window can be copied to the clipboard. Right-click on the window and select Copy to Clipboard. 
These values can be pasted into any text editor or spreadsheet program.

Status bar

The Status bar, located along the bottom of the software window, shows information about the active session. Enable the status bar via 
the View menu.

The bar is divided into four main fields. The left most field displays information about toolbars, error conditions, and playback/recording 
settings. For example, during recording and playback the frame rate is displayed as a Hertz number. The next field to the right is used to 
show the pressure and sensel located under the mouse pointer. This field is updated when the mouse pointer is held over any of the 2D 
views and left mouse button is pressed. The next field to the right shows the date and time of the active frame. The final right most field 
shows either the frame number or the progress of a recording session. The formatting for this frame can be modified in the 
Playback/Recording Options tab.

Adding Session Notes

Notes in the form of text can be added to a session file. These can either be general to the entire file, or specific to a recorded frame. 
Text is entered via the tabs of the Notes window. 

Figure 1

Figure 2  
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Note: To show the Notes window, select  Show Notes Window from the View / Toolbars menu. By default this window is docked 
next to the Statistics window.

General Notes
Use the General tab to enter notes regarding the session file as a whole. General notes can be separated into up to 99 pages. The Insert 

 button inserts an empty page after the current page. Pages can be removed using the Delete page  button. Page navigation 

buttons allow movement between pages either one at a time (  and ), or by moving directly to the first  or last  pages.

General Notes with selected text.

General notes can be saved as a template file (file extension XNT). This allows sharing commonly entered text between session files. 

Use the Template  button to load or save a notes template. A default notes template can be loading on session creation using the 
Notes Template field in the New Session window.

Notes Template Load/Save prompt.

Frame Notes
Use the Frame tab to enter notes that are specific to particular frame. The frame note consists of a single page.

Notes entered for a single frame.
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All Frames
The All Frames tab shows a list of frames that have had notes entered. The frame number and the first part of the note is shown in the 
list. Double-click (using left mouse button) on a row in the list to make that frame active.

All Frames showing the list of frames with frame notes.

Text Editing
Editing such as word selection and cut-copy-paste is available through the normal Windows keyboard shortcuts or by right clicking the 
mouse in the editing field.

Note: The software is presently limited to basic text formatting (I.E.: Spaces and the linefeeds. Tabs are allowed if pasted from 
another source.)

Attaching Images to a Session

One or more picture images can be attached to a session file. These images are displayed in the Images window. Supported image file 
formats include JPEG, PNG and BMP.

Note: To show the Images window, select Show Images Window from the View / Toolbars menu. By default this window is 
docked next to the Notes window.

Images are attached using the Insert  button, or removed with the Delete  button. Previous Image  and Next Image

buttons allow navigation through the attached images. The Save As  button allows exporting of an attached image to an image file.

Image attachments can also be manipulated via the Tools / Attached Images menu.
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The original file names of the attached images are retained and displayed in the Image window.

Removing Frames from a Session

Recorded frames can be removed from a session. The Remove Frames window is accessed via the Tools menu.

The Remove Frames window has three options for frame removal. The current frame can be removed, or a selected range of frames. 
The third option allows removing all frames associated with a recording session. The recording session intervals are shown in a drop-list.

Removing Video

Captured video frames can be removed from a session file. To do this select the video removal  button on the Video Image window to 
access the Remove Video Frames window.

Video frames can be removed individually or by a range of from frames.

Configuring the print layout

When printing an XSENSOR session, you can define which display elements to print, along with their position, size, and stacking order. 
You can also use grid lines to help you align display elements in the page layout, and adjust the margins for your print job.
To perform any of these tasks, from the File menu, choose Print Layout to open the Print Layout dialog box, or click the Print Layout

 toolbar button. Click the underlined links below to find out how to perform a given task.

To choose which display elements to print:

To change the stacking order of display elements:

To move a display element to another part of the layout:

To change the size of a display element:

To use grid lines to align design elements:

To add margins to a print job:
Click the Defaults button to reset all the page layout settings to their default values.

Print Preview

Use the Print Preview option to see what a print job will look like before printing it.

To open the Print Preview dialog box, from the File menu, choose Print Preview, or click the Print Preview  toolbar button. 
Move any display elements if necessary before continuing. 

To change the size of the Print Preview dialog box, hold the pointer over the dialog-box border; the pointer will change to a . 
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Click and drag to change the size of the dialog box. 

To increase or decrease the size of the image, click the Zoom In or Zoom Out buttons. 

To print the image, click the Print button. 

To close the Print Preview dialog box without printing, click the Close button. 
Note: The Next Page, Prev Page, and Two Page buttons are not available when previewing a screen image.

Printing

To print the current view of pressure data, use the following instructions. The layout and printed elements can be adjusted on the print 
layout screen.

1. Open the desired XSENSOR session. 
2. Go to the frame that you want to print (if working in one of the graph views). 
3. Open the Print dialog box in one of three ways: 

From the File menu, choose Print;
OR

Click the Print  toolbar button; 
OR

Press the <Ctrl+P> keys. 
4. In the Printer option group: 

Use the Name drop-down list to select the printer where you want to print the image. 

Select the Print to file check box to output the image to a print (*.prn) file. 

Click the Properties button to set the properties of your printer. The options available will vary depending on the type of printer.
5. In the Print range option group, leave the default selection (All). 
6. In the Copies option group, select the number of copies that you want to print. 
7. Click OK when finished to print the image(s).

Exporting Data

Pressure data can be exported from a session into either a new XSENSOR session file, into text files, or as HTML. The Export Frame 
Data window is used to select the frames, sensors, and groups for export. The frames can be exported wholly, merged to create a single 
average frame, or as just statistics. Select Export from the File menu to open the Export Frame Data window.

Selecting all sensors and groups for export across 12 frames.

Frame Selection
Select Add Current to add the current frame to the list. Note that it is possible to use the frame navigation buttons while this window is 
open to change the current frame. Add Interval is used to add large intervals of frames via the Add Frame Interval window. The Add 
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Special function is used to select frames based on special criteria. This function is covered below in the Add Special Frames section.

Frames can be removed from the list using the Remove and Remove All buttons.

Advanced Options
The advanced options give finer control over the data being exported. Show the advanced options with the Advanced button. 

Use the check boxes to choose which sensors and groups to export. By default all are selected.

Export average of all frames - All frames in the export list are merged together to create a single averaged frame. 

Export Statistics (HTML/Text/CSV files only) - Exports just the statistics for the selected sensors and groups. 

Allow out of sequence frames - Frames can be exported in an arbitrary order. Use the arrow (  / ) buttons to reorder the 
frames. 

Preserve group layout - Sensor group data is exported in the layout that it is defined. The software exports each group in an 
encompassing rectangle. Sensels that are not within the group are marked with an "X". 

Save As...

XSENSOR File - Creates a new session file. This option is disabled when Export Statistics is selected. 
HTML - Creates a web page with the sensor data. 
Text - A tab delimited file of pressure data. This can be imported into a spreadsheet for further processing. 
CSV - A comma delimited file format, which can be imported into spreadsheets. Please note that some spreadsheet programs 
mistakenly treat the comma delimiters as decimals. If this occurs, please use Text export. 

Add Special Frames
Use this function to select frames that match special criteria.

Selecting frames for export based on pressure criteria.

Add all frames with comments - Adds all of the frames that have frame comments. 
Add all frames where - Adds frames that match the statistical criteria. The drop list allows further refinement of the selection 
criteria by allowing selection of sensor and sensor group configurations. 

Importing Data

Frames of pressure data can be imported into a session from other session files or from text based files. The Import feature is accessed 
via the File menu.

Import format selection.

Text Import Format
The Tab Delimited and CSV options share the same file format requirements with the only difference being the data value delimiters. The 
imported data is expected to be structured in rectangular blocks, with one block representing a single sensor pad.
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Each frame of data is identified by a line that begins with the frame tag "FRAME:". (Note the quotes should not be included and the semi-
colon is required.) Any data that falls between the first frame tag and the next is considered to be part of one frame. Within a frame, each 
sensor pad must be identified with the sensor tag "SENSOR:" which must also appear as the first element on a line. The individual rows 
of a sensor are identified with the sensel tag "SENSEL:".

Here is an example of two frames of a two pad system where each sensor has three rows and three columns.

NOTE: If still in doubt of the required import format, try exporting a single frame of data using a text format and examine the 
output.

When importing pressure data from text files, the pressure units are assumed to be in the current display pressure units.

Screen Capture

The easiest way to capture a screen image is to use Window's built-in screen capture function. Simply press the <Print Screen> key to 
capture the entire screen and paste it into a paint program, word processor, or e-mail. Alternatively the software provides a screen 
capture function. Select Capture Screen from the File menu.

Screen Capture setup.

Select the resolution of the captured image. The User Defined option allows images up to 10000 by 10000 pixels. Select a capture view. 
With the Standard option, the software captures whatever is currently displayed in the main session view. The Print Layout option uses 

FRAME: 1
SENSOR: 1
SENSEL: 29.5 32.0 33.0

SENSEL: 28.0 30.0 32.5
SENSEL: 28.5 31.0 32.0

SENSOR: 2
SENSEL: 20.0 21.0 22.5
SENSEL: 19.0 19.5 20.5

SENSEL: 19.5 19.5 20.5
FRAME: 2
SENSOR: 1
SENSEL: 30.0 32.5 32.5
SENSEL: 28.5 30.5 32.0
SENSEL: 29.0 30.5 31.5
SENSOR: 2
SENSEL: 20.5 21.5 22.5
SENSEL: 20.0 20.5 20.5
SENSEL: 19.5 20.0 20.5
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the current Print Layout settings to capture an image.

After the screen is captured, save the image as a PNG, JPG, or BMP type file. PNG offers good compression with no image distortion. 
JPG offers the best compression, but has lower quality. BMP performs no compression, but is the native Windows image format. 
Captured images are in a 24 bit RGB color format.

Movie Capture

Session playback can be captured in an AVI movie format. for viewing outside the XSENSOR software.

Select Capture Movie from the File menu. Set an image resolution, and select the capture view. With the Standard option, the software 
captures whatever is currently displayed in the main session view. The Print Layout option uses the current Print Layout settings to 
capture an image. Press Capture and then specify a location and filename for the captured movie.

Movie Capture Setup

Video Compression

The compression method must be selected for the resulting AVI movie. Select a compressor, and if possible, the compression quality. 
The list of available compressors depends on the computer and version of Windows. Experiment with different compressors to find the 
best compression. XSENSOR recommends "Cinepak Codec by Radius" and "Microsoft Video 1". "Full Frames" can also be selected, 
however, the resulting image files tend to be massive.

While in the Movie Capture mode, the status bar displays AVI in one of its fields.

Exit movie capture by deselecting Capture Movie in the File menu.

About Session Folders

The Sessions window is an easy way to organize session files. The window maps directly to a local disk folder (sorry Network folders are 
not currently supported) and represents a manages viewed of it.

To begin using Session Folders, open the Sessions window (by default located next to the Pressure Legend) right click with the mouse 
and select Set Sessions Folder. In the example below, an existing folder is selected, however, a new folder can be created.

Window's Video Compression screen Compression Options
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The Sessions window showing no selection.

Selecting an existing folder.

The selected folder appears in the Sessions window with the title Session Folders and any sub-folders are listed. Notice that Session 
Folders appears in bolded text. This bolding indicates the active folder. 

The active folder is the default storage location for all new sessions. This location can be changed using by right clicking a folder in the 
session window and selecting Set Active Folder.
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The Sessions window allows other folder operations such as renaming, deleting, and creating new folders.

Session Operations
Session files found in the Sessions window can be opened by either double clicking with the left mouse button, or by right clicking and 
selecting Open Session. The label of an opened session turns red, which indicates that the session cannot be renamed or deleted.

Unopened sessions can be renamed or deleted by right clicking and selecting the corresponding function from the menu.

NOTE: Deleting a session removes it from the computer and cannot be recovered.

Program options

These options are only available in the Advanced medical mode. Look here for the Basic mode options.

Use the Program tab in the Options dialog box to set pressure units and the area units used to calculate surface area, to define the 
format used to display numbers, and to define how pressure bars are drawn in the Pressure Legend window. Click the links below for 
more information about the option groups on this tab.

Units and Formats:

Statistics Window Settings:

Other Options
Basic Medical options
Setting 2D/General Display options
Setting 3D options
Playback/Recording options
Video Capture Options

Sensor Calibration

What is sensor calibration?
Sensor calibration refers to the process of translating raw electronic signals into pressure readings. Each sensor is calibrated in 
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manufacturing to a specified pressure range. A file containing the calibration settings is stored on the sensor. This file is copied from the 
sensor into a folder and is used by the XSENSOR software to perform the raw to pressure translation.

Advanced Topics
Managing Calibration Files
Sensor Recalibration
Raw sensor settings

Raw Settings

Use the Raw Sensor Settings window to adjust a sensor's sensitivity to pressure changes during uncalibrated recording sessions.

Select a sensor from the Active Sensor drop-down list . 

The SPK Performance field affects the maximum possible sampling rate. The Recommended setting is in fact recommended. Click 
here for more information. 

Use the Gain Tx and Gain Rx sliders to adjust sensor signal strength. Larger gain values mean greater signal strength, and as signal 
strength increases, so does sensitivity to pressure changes. For best operation, adjust Gain Tx before Gain Rx, to maximize the noise 
resistance of a sensor. 

The procedure for adjusting the raw sensor gain settings is as follows: 

Set the Rx and Tx gains to a value of 1, and apply the maximum load (as per the application of the sensor). 

Next slowly increment the Tx gain levels until the peak raw value is as close as possible to the maximum while still being below it. 
If the peak raw value is far below the maximum and the Tx gain is at 7, then leave the Tx gain at 7 and slowly increment the Rx 
gain setting until the peak raw value is near, but just below the maximum.

Once this procedure is completed, the sensor pack will be in the optimum mode for raw or uncalibrated measurements.

Sensor Re-calibration

Calibrated sensors ensure optimal performance for clinical or scientific applications. After repeated use, the characteristics of a sensor 
may become modified as a result of subtle changes in the sensor's materials. Updating the calibration file allows the XSENSOR software 
to compensate for changes in the internal properties of the sensor.

Sensor re-calibration requires the XSENSOR Calibration Device. For more information please contact an authorized XSENSOR 
distributor.
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The calibration process has two parts. The first involves selecting a sensor and a pressure range. The second is a series of steps that 
guide the creation of a calibration file.

Calibration setup:
1. From the Tools menu, choose Sensor Calibration, and then Calibrate a Sensor; the Calibration Setup dialog box opens. 

Note:  A sensor cannot be calibrated while a sensor session is being recorded.
2. From the Sensor Pad drop-down list, select the pad that you want to calibrate (if you added more than one pad to your sensor 

configuration, you must calibrate them one at a time). 
3. Select a pressure range from the Pressure Range drop-down list. 

A pressure range represents the minimum and maximum pressure readings that a calibration file supports. Sensor readings that 
fall below the minimum pressure are interpreted as zero pressure. Sensor readings above the maximum pressure are capped at 
10% above the maximum.  

Apply one of the standard ranges that are available with XSENSOR, or create a custom pressure range. Click here for more 
information.

4. Once a pad and pressure range are selected, click the Calibrate button to begin the second part of the calibration process via the 
Manual Sensor Calibration window (below). 

Manual sensor calibration:
1. The Manual Sensor Calibration dialog box has two display areas: The top area shows the step instructions and a flashing step 

button; the bottom area shows a live recording of the sensor. 
2. To calibrate the pad, follow the instructions given for each step. Pressure readings should be performed using a pressure gauge 

connected to the XSENSOR calibration device (as per the XSENSOR Calibration Device and User's Guide.) 
The calibration steps vary depending on the type of pressure range selected (Standard or Custom), but in general, the steps consist 
of gain optimization, pressurization, and finally depressurization. When the final depressurization step is finished, a Save Calibration 
File dialog box opens, showing the status of the new calibration file, including whether there are any problems with the file.
Problems might arise if the instructions were not followed properly, or if there are issues with the sensor. The dialog box also shows 
the location of the "Xsensor Calibrations" folder, and has a button for setting the folder. This folder must be set, and the calibration file 
must saved to it before the XSENSOR software can use the calibration file.

See also:
Managing sensor pressure ranges and calibration memory

Managing calibration files and sensor memory

Use the Calibration Manager window to change the active pressure range of a sensor, or to manage the calibration files stored on the 
sensor.

To change the pressure range of a sensor:
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Managing Sensor Calibration Memory:

About sensor groups

Sensor groups are user-defined collections of sensor cells that can span one or more sensors. Sensor groups are used to gather 
statistics (area and pressure) from small areas of interest, which can be graphed or exported to a text file.

Up to 32 groups can be defined via the Sensor Groups dialog box.  Each group can be as small as one cell, or can include just over 
65000 cells (enough to cover an entire 256-by-256 sensor).  Sensor group layouts are internally saved in a XSENSOR session file, and 
can also be saved externally as a template, which can then be loaded for use with other XSENSOR sessions.

Viewing Sensor Groups
Sensor groups appear in the 2D and 3D pressure map viewing modes (2D, 2D Cross Section, and 2D Numeric) whenever the Sensor 
Groups window is open or when the Show Sensor Groups menu item is checked.  Groups can be edited in all the 2D views, except 2D 
Cross-Section.

To show or hide all sensor groups, choose Show Sensor Groups in the Tools / Sensor Groups menu. 

To show individual cells of all sensor groups, uncheck Show Groups as Outlines in the Tools / Sensor Groups menu. 

See Also:
Creating, editing and deleting sensor groups
Loading and saving sensor group templates

Creating, editing and deleting sensor groups

Sensor groups are created, edited or deleted in the Sensor Groups dialog box, which can be opened using one of the following 
methods:

Click the Sensor Groups  toolbar button; 
OR

From the Groups menu, choose Edit Sensor Groups; 
OR

Double-click a sensor group cell while in the 2D view. 

Click the links below for more information about the various editing options:

To create a new group:

To select one or more groups:

To edit group settings:

To add or remove cells in a selected group:

To move groups around a sensor:

To export group statistics and values:

To delete one or more groups:

To graph sensor group data:

Loading and saving sensor group templates

Sensor group layouts can be saved to an XSENSOR Group Template file (extension .XGT). A group template can be loaded into an 
existing session (replacing any current group layout), or when creating a new XSENSOR session.

Click the links below for more information about saving and loading sensor group templates.

To save a sensor group template:

To load a sensor group template into an existing open XSENSOR sessoin:

To automatically load a sensor group template for new XSENSOR sessions:

Managing the X3 DISPLAY/MOBILE

Use the X3 DISPLAY/MOBILE Manager to manage sessions , calibration files, and note templates on the X3 DISPLAY/MOBILE. To 
open the Manager window, from the Tools menu, choose X3 DISPLAY Manager.
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To connect to the X3 DISPLAY/MOBILE:
Attach the X3 DISPLAY or MOBILE to the computer via the ActiveSync/COM cable, and then click the Connect button.  The Sessions
list displays any session files located on the device's storage cards. (The Card field shows either CF for Compact Flash, or SD for Secure 
Digital).

To copy and erase sessions:
Sessions files can be copied and removed from the X3 device via the Sessions list. To perform either of these operations, select the 
check boxes beside the session names and do the following:

Select the Copy to Folder button to copy the selected sessions into any folder on the PC. 

Select the Copy to Active Client button to copy the selected sessions into the active client folder. 
Note: Copying session files may take several minutes, depending on the size of the files.

Select the Erase button to remove sessions from the X3 device. This operation frees up memory for further recording. 

To set the X3 DISPLAY/MOBILE clock:
Select Update Device Clock to synchronize the X3 device clock with the computer's clock. Note that only the UTC time is updated. The 
time zone and/or daylight savings time settings are unaffected.

To disconnect the X3 DISPLAY/MOBILE:
To disconnect from the X3 device, press the "X" in the top right corner of the Manager window.

To manage pressure ranges:
This is covered in detail in a separate topic.

To manage Note templates:
This is covered in detail in a separate topic.

To manage the X3 MOBILE Configuration:
This a future release feature.

Manage X3 DISPLAY pressure ranges
Use the X3 DISPLAY Calibration Manager window to manage the calibration files and active pressure ranges for sensors used with the 
portable X3 devices.
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The Manager window:
The Sensor Pad drop list shows all sensors that have been connected to the X3 device. The Active Pressure Range drop list shows all 
of the available pressure ranges present on the X3 device, including "Uncalibrated" for raw recordings. The pressure range shown is 
active, meaning a new session will use that range.

The DISPLAY/MOBILE Pressure Ranges list shows all of the calibration files present on the X3 device for the selected Sensor Pad. 
(This is the same as the Active Pressure Range drop list). The Available Pressure Ranges lists shows the calibration files on the 
computer that are available for the selected sensor.

Select one or more (CTRL+left mouse) calibration files in the DISPLAY/MOBILE Pressure Ranges list and press the Download
button to copy calibration files from the portable X3 device to the calibration cache. 
Select one or more calibration files in the DISPLAY/MOBILE Pressure Ranges list and press the left Erase button to erase 
calibration files off the X3 device. 
Select one or more calibration files in the Available Pressure Ranges list to either copy them to the X3 device (via the Upload
button) or erase them from the computer's calibration cache (via the right Erase button). 

Manage X3 DISPLAY Note Templates
The X3 DISPLAY has the capability of storing notes in each session file. To facilitate the entry of notes, a file called a note template can 
be created on the desktop and saved to the X3 DISPLAY. Select the Notes Template from the X3 DISPLAY Manager screen.

The Note Templates window lists templates present on the X3 DISPLAY. Templates can be created, edited, copied and erased. To 
perform an action on a template, first select it from the list. The Default button is used to flag a template so that it is automatically loaded 
when a new session is created.

Templates can be copied between the desktop computer and the X3 DISPLAY. Use Import to copy from the desktop to the X3 
DISPLAY, and Export to copy the selected template to the desktop.
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The Note Template Editor allows entry of text based on the expected X3 DISPLAY format. Text on the X3 DISPLAY is separated into 
pages, each of which can contain a maximum of 1000 characters. Each template can have up to 99 pages.

A template requires a name before it can be saved. The card list shows the available storage cards on the X3 DISPLAY. Select CF for 
Compact Flash, or SD for Secure Digital. The CF and SD cards are only lists if present in the card slot. The storage card list is not 
selectable when editing an existing template.

Use First, Prev and Next to navigate the note pages. Insert and Delete are used to create or remove note pages. The standard 
Windows key combinations can be used for cut-copy-pasting text, CTRL+X, CTRL+C and CTRL+V respectively.

Customizing Toolbars and Windows

The XSENSOR desktop software features the ability to change the layout of its toolbars and docking window. Docking windows can be 
repositioned by selecting the window title-bar or tab (if tabbed) and dragging to a new position.

To show and hide a toolbar or docking window, open Toolbars from under the View menu and make a selection.

To add or remove buttons from the toolbars, select Customize from under the Toolbars / View menu.

Troubleshooting

Sensor is not appearing:
1. Check physical connections. Ensure each connection has a good fit all the way to the computer.
2. Check the X3 SPK or X3 PRO SPK for a green power indicator light. If this light is not on or is amber, the SPK is not receiving 
sufficient power to operate.
3. Check the green power light on the X3 or X3 PRO connector hub. Ensure the hub is on (press the power button) and plugged into an 
outlet that has power.
4. Check the Device Manager for each SPK:

Open the Control Panel and select System. Choose the Hardware tab and press the Device Manager button. Look for an entry called 
Human Interface Devices.
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For each attached SPK, there should be a "HID-compliant device" entry. To confirm the entry corresponds to an SPK, right click on it and 
select Properties.

Under Device Instance ID, the string "VID_1891&PID_0000" should appear. This indicates the device is an XSENSOR SPK.

If an entry for the SPK does not appear after a minute, recheck connections. It is possible that the USB port on the PC is overloaded due 
to other USB devices. Try plugging the X3 or X3 PRO hub into another USB port.

Sensor is recording very slowly:
1. Open the New Session window. Try entering a larger recording speed. If the recording speed is stuck on 1 frames per second, then 

Seite 62 von 64Medical Modes: Basic and Advanced

29.01.2015file:///C:/Users/dm/AppData/Local/Temp/~hh92FD.htm



that might indicate a connection problem. A common cause for that is a missing USB 2.0 extender cable. If the XSENSOR system was 
shipped with a USB 2.0 extender cable, then it must be used to ensure proper operation.
2. The performance of the system can be affected by the USB components used in the computer. Laptop computers in particular use 
components that may not be able to operate at the speeds required by the XSENSOR sensor hardware. Please try the XSENSOR 
system on another computer (of different make or brand.)

If these problem persist, or your problem does not appear here, please contact XSENSOR technical support.

See X3 Connection Status for more diagnostic information.

X3 Connection Status
The X3 Connection Status window shows details about each sensor connected to the computer.  The listed details vary depending on 

the sensors.  Open this window via the X3 Connection Status / Tools menu or by the Connection Status  button.

Some common details include Usage Statistics, Advanced Features, and sensor pack firmware version information.  Usage statistics 
show the number of recording sessions and the total recording duration for a pad.  Usage statistics also show how long it has been since 
a pad was last calibrated.  The Advanced Features and Sensor Pack Firmware details tells the XSENSOR Desktop software what 
features and capabilities are supported by the sensor pads. 

Use Toggle View to toggle the view between a graphical representation of the sensors and a detailed text view. The Refresh Sensor 
List button is used to force the window to refresh its contents.  Use Copy to Clipboard to copy the connection details to a document or 
e-mail.

Graphical view of the connection status.
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Detailed view of the connection status.

How to reach us
Company Information
XSENSOR Technology Corporation is the leading innovator of advanced pressure imaging solutions for the patient safety, sleep, and 
automotive testing markets. Offering superior sensors, custom solutions and X3 technology, XSENSOR is an internationally recognized 
leader with customers in over 50 countries.

Contact Information
Phone:
North America: 1.403.266.6612
Toll-free (North America): 1.866.927.5222
Toll-free (International): 0011.800.5913.4444
Extension 240 for technical support.

Fax:
1.403.205.4013

Email:
support@xsensor.com

Address:
Suite 111, 319-2nd Ave SW
Calgary, AB, T2P 0C5
CANADA

Web:
www.xsensor.com
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